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Прогноз функционального результата хирургического 
лечения при сквозном макулярном разрыве на основании 

анализа сохранности ретинальной ткани
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резЮме

цель: изучить связь оцениваемых с помощью оптической когерентной томографии (ОКТ) характеристик сохранности нейро-
сенсорной сетчатки и пигментного эпителия сетчатки (ПЭС) с функциональным восстановлением при хирургическом лечении 
сквозных макулярных разрывов (СМР). Пациенты и методы. Пациенты с полным послеоперационным анатомическим закрыти-
ем СМР были включены в проспективное интервенционное исследование: 29 пациентов (30 глаз, 23 женщины и 6 мужчин) со 
средним возрастом 66,2 ± 5,2 года. Все пациенты получили стандартное офтальмологическое обследование и ОКТ до хирурги-
ческого лечения. На кросс-секционных и анфас изображениях были оценены площадь и рефлективность ткани нейросенсорной 
сетчатки по краям разрыва и ПЭС в проекции разрыва соответственно. Через 6 месяцев после хирургического лечения была 
оценена корреляция между исходными показателями сохранности ретинальной ткани и функциональным восстановлением. 
результаты. Финальная острота зрения показала статистически значимую корреляцию с исходной остротой зрения (r = 0,75, 
p < 0,001), рефлективностью ПЭС (r = 0,81, p < 0,001), рефлективностью ткани сетчатки (r = –0,88, p < 0,001) и ее площа-
дью (r = 0,41, p = 0,02). заключение. Показатели сохранности ретинальной ткани, включая площадь и рефлективность ткани 
нейросенсорной сетчатки и рефлективность ПЭС, коррелируют с функциональным восстановлением после хирургии СМР.
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введение

В настоящее время заболевания макулярной обла‑
сти являются одной из ведущих причин слабовидения 
в группе пациентов пожилого и старческого возраста 
населения развитых стран [1]. Одним из таких забо‑
леваний, приводящих к выраженному снижению цен‑
трального зрения, является сквозной макулярный раз‑
рыв (СМР).

Единственным эффективным методом лечения СМР 
в настоящее время остается хирургический на основе 
трехпортовой трансцилиарной микроинвазивной ви‑
трэктомии [2, 3]. С учетом развития методик современ‑
ной витреоретинальной хирургии [4] и эволюции суб‑
стратов для тампонирования макулярного дефекта [5] 
анатомическое закрытие разрыва чаще всего не вызыва‑
ет затруднений и достигается с достаточно высокой ча‑
стотой (в 92–97 % случаев) [6, 7]. Однако данные по вос‑
становлению зрительных функций после хирургии СМР 
неоднородны и порой противоречивы [8, 9].

В настоящее время не сформулированы четкие пока‑
зания для оперативного лечения СМР, и зачастую нали‑
чие разрыва воспринимается как абсолютное показание 
к операции. При этом существует риск интра‑ и после‑
операционных осложнений, способных ухудшить в зна‑
чительной мере и без того низкое зрение [10,  11]. Все 
это требует соотнесения риска осложнений и непосред‑
ственной пользы от операции.

Для прогнозирования функционального результата 
и определения показаний к оперативному лечению СМР 
авторами в разное время предложен ряд клинико‑анато‑
мических критериев, обладающих определенной практи‑
ческой ценностью. В качестве таких критериев рассма‑
тривались: длительность существования макулярного 
разрыва [12]; уровень цветной контрастной чувстви‑
тельности [13]; дооперационная острота зрения [14]; 
«тракционный индекс разрыва» [15] и другие критерии.

Появление сквозного дефекта в сетчатке сопровожда‑
ется формированием интраретинального кистозного 
скопления жидкости и прогрессирующими нейродегене‑
ративными изменениями сетчатки [16]. Количественная 
оценка перечисленных дегенеративных структурных из‑
менений макулярной сетчатки на фоне СМР позволяет 
сделать функциональный прогноз оперативного лечения 
точнее. Однако простые алгоритмы оценки сохранности 
ретинальной ткани носят приблизительный характер. 
В частности, показатель центральной толщины сетчат‑
ки косвенно отражает количество ретинальной ткани. 
Однако вклад интраретинальной жидкости искусствен‑
ным образом завышает эту величину и ведет к пере‑
оценке функционального исхода, маскируя нейродегене‑
рацию, что не позволяет использовать этот и некоторые 
другие аналогичные подходы для функционального 
прогноза [17]. Алгоритмы оценки вклада нейродегенера‑
ции на фоне интраретинальной жидкости были описа‑
ны для неоваскулярной формы возрастной макулярной 
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дегенерации (нВМД) и диабетического макулярного оте‑
ка (ДМО). Этот подход описывает нейродегенеративные 
изменения с двух позиций: количества сохранной ткани 
сетчатки и ее качества, определенного по рефлективно‑
сти ткани сетчатки [18]. Этот подход может быть эффек‑
тивен и в прогнозе хирургии макулярных разрывов.

Однако, в отличие от ДМО и нВМД, функциональ‑
ный исход при макулярных разрывах зависит и от со‑
хранности ПЭС, так как формирование СМР приводит 
к обнажению пигментного эпителия сетчатки, что сопро‑
вождается прямым механическим воздействием на него 
компонентов стекловидного тела, вызывающих его по‑
степенную атрофию [19]. В условиях потери ПЭС даже 
удовлетворительное состояние нейросенсорной сетчат‑
ки не позволяет рассчитывать на функциональное вос‑
становление. Таким образом, прогноз функционального 
восстановления при хирургии СМР должен отражать 
статус ПЭС одновременно с показателями сохранности 
ткани нейросенсорной сетчатки.

В связи с этим целью исследования было изучение 
связи оцениваемых с помощью оптической когерентной 
томографии (ОКТ) характеристик, отражающих сохран‑
ность ретинальной ткани (нейросенсорной сетчатки 
и ПЭС) с функциональным восстановлением при хирур‑
гическом лечении СМР.
Пациенты и методы

В проспективное интервенционное исследование 
были последовательно включены 29 пациентов (30 глаз), 
оперированных по поводу СМР. Всем пациентам вы‑
полнена микроинвазивная витрэктомия 25G через пло‑
скую часть цилиарного тела, окрашивание и удаление 
задней гиалоидной мембраны, пилинг внутренней по‑
граничной мембраны, механическое сведение краев раз‑
рыва, аппликация на поверхность разрыва аутоплазмы 
и тампонада витреальной полости воздухом с позицио‑
нированием лицом вниз до утра следующего дня после 
операции. У всех пациентов достигнут положительный 
анатомический результат операции в виде закрытия 
макулярного разрыва. Критериями исключения было 
незакрытие разрыва в раннем послеоперационном пе‑
риоде, близорукость более 6,0  D и дальнозоркость бо‑
лее 2,0  D для факичных пациентов, а также известная 
высокая близорукость (более 6,0 D) для артифакичных 
пациентов, подтвержденная величиной ПЗО 26,0  мм 
и более, качество сигнала ОКТ до операции менее 70 % 
или интегральное качество скана ОКТА менее Q7. 
Из исследования исключали также пациентов, имеющих 
в анамнезе офтальмологическую патологию, влияющую 
на центральное зрение (нарушение прозрачности опти‑
ческих сред, закрытые и открытые травмы глаза, диа‑
бетическая ретинопатия, глаукома, отслойка сетчатки, 
посттромботическая ретинопатия и др.). Все пациенты, 
включенные в исследование, имели интраокулярную 
линзу либо им была проведена одномоментная фако‑
эмульсификация.

Пациентам до оперативного лечения, а также 
через 6  месяцев после операции проводилось полное 
офтальмологическое обследование, включавшее, в том 
числе, определение максимальной корригируемой остро‑
ты зрения (МКОЗ) по таблицам ETDRS, а также вы‑
полнение ОКТ на приборе RTVue‑XR Avanti (Optovue, 
США). ОКТ исследование включало паттерн Radial Lines 
(18 кросс‑секционных сканов длиной 6 мм, взаимно пере‑
секающихся в центре фовеа). Для анализа использовался 
горизонтальный скан, проходящий строго через центр 
разрыва. В программном обеспечении томографа на этих 
изображениях измеряли расстояние между краями раз‑
рыва. Кроме того, всем пациентам была выполнена ОКТ‑
ангиография паттерном 6 мм (400 повторных В‑сканов 
по 400 А‑сканов каждый). Анализ изображений проводи‑
ли с помощью программного пакета ImageJ (NIH, Бетесда, 
США). На анфас изображениях выделяли зону внутри 
от краев разрыва и измеряли ее среднюю яркость.

расчет средней Площади и средней 
оПтической Плотности сетчатки

Среднюю площадь, а также среднюю оптиче‑
скую плотность ретинальной ткани рассчитывали 
на кросс‑секционных сканах ОКТ, проведенных строго 
через центр разрыва (рис. 1).

Зону интереса на скане выделяли с использовани‑
ем функции Polygon selection от ПЭС до внутренней 
пограничной мембраны в пределах 1500 мкм от края 
разрыва (по 1500 мкм в каждую сторону от края раз‑
рыва). Микрокисты и участки интраретинального ско‑
пления жидкости определяли с использованием пути 
Image>Adjust>Threshhold, Edit>Selection>Create  selec‑
tion, выделяя все участки, имеющие равную или мень‑
шую оптическую плотность по сравнению со сте‑
кловидным телом. Далее выделение инвертировали 
и таким образом получали выделение только ткани 
сетчатки без интраретинального скопления жидкости, 
для которой определяли общую площадь и среднюю 
рефлективность.

расчет средней оПтической Плотности 
Пигментного эПителия сетчатки

Для анализа использовали структурную анфас‑про‑
екцию, полученную между двумя линиями сегментации 
мембраны Бруха в позиции 0 и ‑9 мкм. Исследуемый уча‑
сток ПЭС на оптическом срезе выделяли с использова‑
нием функции графического редактора Polygon selection 
в границах СМР, в пределах выделенной зоны через ал‑
горитм Analyze>Measure рассчитывалась средняя опти‑
ческая плотность ПЭС (рис. 2).

Для статистической обработки данных использова‑
ли программный пакет MedCalc 18.4.1 (MedCalc Software, 
Бельгия). Данные представлены как среднее ± стандарт‑
ное отклонение. Коэффициент корреляции Спирмена 
использовали для оценки наличия связи между по‑
казателями МКОЗ или ее прибавкой и исследуемыми 
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ОКТ‑параметрами, а также 
клиническими и демографи‑
ческими характеристиками. 
Мультифакториальные регрес‑
сионные модели были постро‑
ены для конечной МКОЗ и ее 
прибавки и включали возраст, 
длительность симптомов, ис‑
ходную остроту зрения и ОКТ‑
параметры. Статистически зна‑
чимыми считали различия 
при p < 0,05.
результаты

Базовые клинико‑демографи‑
ческие характеристики пациен‑
тов представлены в таблице 1.

Исходная острота зрения
Исходная острота зрения по‑

казала статистически значимую 
корреляцию с минимальным 
диаметром разрыва (r = ‑0,72, p < 
0,001), длительностью симптомов 
(r  = ‑0,62, p  < 0,001), рефлектив‑
ностью ПЭС (r = 0,51, p = 0,004), 
рефлективностью ткани сетчатки 
(r = ‑0,62, p < 0,001).

Финальная острота зрения
Финальная острота зрения 

показала статистически значи‑
мую корреляцию с исходной 
остротой зрения (r = 0,75, p < 0,001), диаметром разры‑
ва (r  = ‑0,63, p  < 0,001), длительностью симптомов (r  = 
–0,59, p  < 0,001), площадью ткани (r  = 0,41, p  = 0,02), 

рефлективностью ПЭС (r = 0,81, p < 0,001), рефлективно‑
стью ткани сетчатки (r = –0,88, p < 0,001). В многофактор‑
ном анализе исходная острота зрения, рефлективность 

рис. 2. Пример вычисления средней оптической плотности ПЭС у пациента с СМР. А — cтруктурная en face проекция; В — выделенный 
участок ПЭС, соответствующий границам СМР, для расчета средней оптической плотности (средняя оптическая плотность — 202,5)

Fig. 2. An example of calculating the average optical density of RPE in a patient with FTMH. А — structural en face projection; B — the se-
lected section of the RPE corresponding to the boundaries of the FTMH for calculating the average optical density

рис. 1. Пример расчета площади и средней оптической плотности ткани сетчатки у пациента 
со СМР. А — кросс-секционный скан оптической когерентной томографии до хирургического 
лечения; В — зона интереса в пределах 1500 мкм от края разрыва; С — исследуемый уча-
сток сетчатки; D — определение порога яркости для ткани сетчатки; Е — выделение ткани 
сетчатки; F — расчет площади и средней оптической плотности на участке сетчатки без 
учета интраретинального скопления жидкости (средняя площадь оптического среза сетчат-
ки — 78 380, средняя оптическая плотность — 86,9)

Fig. 1. Example of calculating the area and average optical density of retinal tissue in a patient with 
the full thickness of the macular hole. A — cross-sectional scan of optical coherence tomography 
before surgical treatment; B — the area of interest is within 1500 microns from the edge of the 
macular hole; C — the studied area of the retina; D — determination of the brightness threshold 
for retinal tissue; E — isolation of retinal tissue; F — calculation of the area and average optical 
density in the retinal area, excluding intraretinal fluid accumulation
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ПЭС и ткани сетчатки показали независимую связь 
с финальной остротой зрения (p < 0,05).

Прибавка остроты зрения
Прибавка остроты зрения показала статистически 

значимую корреляцию только с исходной остротой 
зрения (r = –0,6, p < 0,001). В многофакторном анализе 

исходная острота зрения, рефлективность ПЭС и тка‑
ни сетчатки показали независимую связь с прибавкой 
остроты зрения (p < 0,05).

Полученная корреляция показателей остроты зрения 
с исследуемыми характеристиками представлена в та‑
блице 2.

Наиболее информативные корреляционные пока‑
затели изучаемых параметров приведены на точечных 
диаграммах (рис. 3).
обсуждение

Прогнозирование анатомического и функциональ‑
ного результата является важной частью лечения паци‑
ентов с СМР. Исследования в области прогнозирования 
функционального результата неотъемлемо сопрово‑
ждают эволюцию методов оперативного лечения СМР 
и бывают тем точнее, чем совершеннее и деликатнее 
становятся сами методы оперативного лечения, а также 
насколько совершеннее становятся средства предопера‑
ционной диагностики.

В большом числе работ были предложены различные 
критерии прогноза оперативного лечения СМР, такие 
как длительность существования макулярного разры‑
ва, дооперационная острота зрения, уровень цветной 
контрастной чувствительности и др. Морфологические 
критерии функционального прогноза, основанные 
на различных индексах, включающих показатели 

таблица 2. Корреляция показателей остроты зрения с исследуемыми характеристиками

table 2. Correlation of visual acuity indicators with the studied characteristics

Исходная острота зрения
Initial visual acuity

Финальная острота зрения
Final visual acuity

Прибавка остроты зрения
Increased visual acuity

Возраст / Age r = –0,16, p = 0,38 r = –0,32, p = 0,09 r = –0,14, p = 0,48

Исходная острота зрения / Initial visual acuity – r = 0,75, p < 0,001 r = –0,6, p < 0,001

Диаметр / Diameter r = –0,72, p < 0,001 r = –0,63, p < 0,001 r = 0,32, p = 0,08

Длительность / Duration r = –0,62, p < 0,001 r = –0,63, p < 0,001 r = 0,24, p = 0,21

Площадь ткани / Area of retinal tissue r = 0,25, p = 0,19 r = 0,41, p = 0,02 r = 0,13, p = 0,5

Рефлективность ткани / Reflexivity of retinal tissue r = –0,62, p < 0,001 r = –0,88, p < 0,001 r = 0,13, p = 0,48

Рефлективность ПЭС / Reflexivity of RPE r = 0,51, p = 0,004 r = 0,81, p < 0,001 r = 0,21, p = 0,26

таблица 1. Базовые клинико-демографические характеристики 
пациентов, включенных в исследование

table 1. Basic clinical and demographic characteristics of patients 
included in the study

Показатель / Parameter Числовое значение / Value

Пол, м/ж / Gender, m/w 6/23

Возраст лет / Age, year 66,23 ± 5,24 (59–80)

МКОЗ до операции / Vision before surgery 0,15 ± 0,07 (0,04–0,3)

Количество знаков ETDRS до операции /  
Number of ETDRS characters before the operation 50,27 ± 9,03 (27–65)

Прибавка количества знаков ETDRS после операции /  
Increase in the number of ETDRS characters after surgery 19,97 ± 5,98 (5–35)

Минимальный диаметр СМР, мкм /  
Minimum diameter FTMH, microns 474,77 ± 148,10 (212–737)

Длительность течения СМР, месяцев /  
Duration of the course of FTMH, months 7,3 ± 5,68 (2–24)

Стадия СМР, число глаз / Stage of FTMH, number of eyes
II
III
IV

7
17
6

рис. 3. Точечные диаграммы корреляции финальной остроты зрения с исходной остротой зрения (А), рефлективностью ПЭС (B) и реф-
лективностью ткани сетчатки (C)

Fig. 3. Dot diagrams of the correlation of final visual acuity with initial visual acuity (A), reflexivity of the RPE (B) and reflexivity of the retinal 
tissue (C)
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минимального и базального диаметра, высоту краев, 
объем СМР, лучше прогнозируют и анатомический ре‑
зультат, и, в меньшей степени, функциональный [12–15].

В этом исследовании было показано, что такие 
предложенные нами параметры, как прогрессирующее 
уменьшение средней площади с увеличением оптиче‑
ской плотности ткани сетчатки по краям разрыва вме‑
сте со снижением оптической плотности ПЭС, хорошо 
коррелируют и наглядно отражают прогрессирование 
дегенеративных изменений в макуле, вызванных форми‑
рованием СМР и обусловливающих неудовлетворитель‑
ный функциональный прогноз.

Функциональный результат при лечении СМР опре‑
деляется состоянием ткани сетчатки в фовеа и статусом 
ПЭС. Эти структуры подвергаются альтерации на фоне 
персистирования макулярного разрыва из‑за аккуму‑
ляции интраретинальной жидкости и контакта ПЭС 
с компонентами стекловидного тела. Это соответству‑
ет известной корреляции между длительностью суще‑
ствования разрыва и окончательной остротой зрения, 
что нашло подтверждение и в нашей работе.

В проведенных ранее исследованиях было показано 
наличие высокой корреляции между показателями фи‑
нальной остроты зрения со средней площадью и опти‑
ческой плотностью ретинальной ткани в центре макулы 
[18], а также показателями оптической плотности маку‑
лярного ПЭС [20] при прогнозировании функциональ‑
ного результата лечения ДМО и нВМД.

Выполненная нами работа демонстрирует высокую 
корреляционную связь между показателями финаль‑
ной послеоперационной остроты зрения и средней пло‑
щадью сетчатки, средней оптической плотностью ПЭС 
и обратную корреляционную связь с показателем сред‑
ней оптической плотности сетчатки при СМР.

Описанные критерии функционального прогноза 
достаточно просты в вычислении, не требуют специ‑
альных навыков и длительного времени расчета, с боль‑
шой достоверностью количественно способны отражать 
степень дегенеративных изменений в нейросенсорной 
сетчатке и ПЭС при СМР. Важное преимущество ис‑
следуемых критериев  — их оценка только с помощью 
ОКТ, которая в настоящее время является наиболее 

универсальным и распространенным диагностическим 
инструментом в ретинологии.

Сетчатка и ПЭС составляют единую систему, и оцен‑
ка только одной части этой системы (или сетчатки, 
или ПЭС) не может гарантировать надежный функци‑
ональный прогноз. Одновременная оценка нейросен‑
сорной сетчатки и ПЭС является принципиальной иде‑
ей предлагаемого подхода и потенциально надежным 
предиктором. Кроме того, оценка ретинальной ткани 
в данной работе включает не только количественные 
(площадь на ОКТ скане), но и качественные (рефлектив‑
ность) показатели. Последний крайне важен для оценки 
выраженности нейродегенерации фоторецепторного 
аппарата, имеющего ключевое значение для восстанов‑
ления остроты зрения. Повышение рефлективности сет‑
чатки незначительно влияет на количественные показа‑
тели расчета, но напрямую отражает сохранность слоя 
фоторецепторов, имеющего минимальную рефлектив‑
ность.

Несмотря на выявление связи финальных зритель‑
ных функций с описанными критериями, исследование 
требует большего количества наблюдений для повыше‑
ния достоверности. К ограничениям применения разра‑
ботанного алгоритма прогнозирования в рутинной кли‑
нической практике также можно отнести необходимость 
адаптации методики для различных моделей томогра‑
фов в связи с их отличиями, касающимися разрешающей 
способности и программного обеспечения.

В этой работе мы показали высокую степень кор‑
реляции показателей сохранности ретинальной ткани, 
включая площадь и рефлективность ткани нейросенсор‑
ной сетчатки по краям разрыва, рефлективность ПЭС 
в проекции разрыва, с функциональными результатами 
хирургического лечения. Данные показатели достоверно 
отражают сохранность структур сетчатки, ответствен‑
ных за высокую остроту зрения, и могут быть исполь‑
зованы в прогнозировании результатов хирургии сквоз‑
ных макулярных отверстий.
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